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Announcement

講義で使用するサンプルについて

■ マルウェアのコードを含むため、指定した環境以外では取り扱わないこと

○ ワークショップ終了後は削除すること

■ ワークショップ内で指定したファイル以外は実行はしないこと

■ 第三者および外部ウェブサービス（VirusTotalなど）に、
提供・アップロードしないこと
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Setup

1. SlackからzipファイルをDL

2. 当日に配布したパスワードで下記パスにzip
の中身を展開

C:¥yara_pretty_darby
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Introduction YARA
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YARA

マルウェアを検知、分類するためのOSSツール

■ シグネチャ（ルール）を定義し、合致するパターンを検出

■ ファイルやメモリなど、さまざまな種類のデータに対して検索可能

スキャンスキャン

“41 6c 6c 73 61 66 65” 
が含まれるか？（=ルール）

A  l  l  s  a  f  e
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YARA for InfoSec

具体的にどのような場面で使用するのか？

■ Analysis

○ 類似ファイルをみつけてファミリを特定する

○ マルウェア内で使われている手法（暗号方式・パッカーなど）を特定する

■ Detection

○ IR中に見つけた不正ファイルと類似するファイル・プロセスを検索する

○ 特定の通信先やファイルパスが含まれるファイル・プロセスを検索する

■ Hunting

○ 類似ファイルが外部サービス（VirusTotalなど）で公開されるのを監視する
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YARA in Tools

■ サンドボックス、EDR

○ e.g. Cuckoo Sandbox, CAPE

○ 多くの商用製品がYARAルールに対応している

■ メモリフォレンジックツール

○ e.g.  Volatility

9



Basics of YARA



YARA, rule them all

YARAルールは、独自の構文で記述される

■ 文字列やバイナリパターンなどのシグネチャ (stringsセクション)と、それらの組み合わせ条件式
(conditionセクション)をもとに、検出ロジックを組み立てる
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• ルールに関するメタ情報を
キーバリュー形式で記述

• ルール作成者や作成日など

• 完全自由記述

• 検出対象の名前（自由記述）

• マルウェア名やテクニック名
など

• 検索したいデータを定義

• $<任意の変数名> = <パターン>

• 文字列や Hexを指定可能

• 正規表現も利用可能

メタデータ

ルール名

シグネチャ

条件式

• 検出のための条件式を記述

• stringsセクションで定義した
データの組み合わせ条件を指定



strings section

stringsセクションで指定可能なさまざまなパターン

■ HEX文字列（{}でくくる）

○ ワイルドカード（?）

○ 可変調データ表現（[n-m]）

■ テキスト文字列（””でくくる）

○ エンコーディング（ascii/wide）

○ ケースインセンシティブ（nocase）

■ 正規表現（//でくくる）
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condition section

conditionセクションで指定可能なさまざまなパターン

■ 比較式

○ <=, >=, <, >, ==, !=

■ 論理式

○ and, or

■ セット

○ any of them, all of them, # of ($*)

■ データへのアクセス

○ uint(8|16|32), int(8|16|32), etc

■ キーワード

○ filesize
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例: MZ/PEヘッダをチェックしてから条件式を評価

例: stringセクションで定義した変数名に対して、
ワイルドカードを使用して指定することも可能



modules

機能拡張のためのモジュールも利用可能

■ pe: PEファイルの構造に簡単にアクセスするためのモジュール

■ hash:  ハッシュ値を計算するためのモジュール

■ dotnet: .NETファイルの属性情報にアクセスするためのモジュール
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peモジュールを使用し、
特定のAPIのインポート
などを検出条件にして
いる



YARA Docs

■ 細かい仕様は公式ドキュメントで確認する

○ https://yara.readthedocs.io/en/stable/writingrules.html
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For more detail

プロダクションレベルのルールを読むのが一番

■ https://github.com/Yara-Rules/rules

■ https://github.com/Neo23x0/signature-base/tree/master/yara

■ https://github.com/kevoreilly/CAPEv2/tree/master/data/yara

■ https://github.com/eset/malware-ioc/

■ https://github.com/JPCERTCC/MalConfScan/blob/master/yara/rule.yara

■ https://github.com/InQuest/awesome-yara

16

https://github.com/JPCERTCC/MalConfScan/blob/master/yara/rule.yara


Make YARA rules with Ghidra
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What is Ghidra?

ソフトウェアリバースエンジニアリングツールセット

■ 2019年にNSAによってOpen Source Softwareとして公開

○ https://github.com/NationalSecurityAgency/ghidra

■ フリーでありながら、強力な機能を提供

18

https://github.com/NationalSecurityAgency/ghidra


Ghidra’s basic features

Disassembler/Decompiler

多様なアーキテクチャに対応した
ディスアセンブラに加え、

擬似C言語へ変換するデコンパイラ機能

Ghidra Script

Ghidraの各種機能をスクリプト
(Java/Python)から利用可能

Ghidra Extension

自作プラグインによる
機能拡張をサポート

Headless Analyzer

CLI経由での操作

Ghidra Server

複数ユーザによる共同作業を
サポート

Debugger

GDB/WinDBGをバックエンド
としたデバッグ機能を提供
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Ghidra Usage



Set up, Ghidra…
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■ Ghidraのインストール・セットアップについては、事前に共有したURLを
参考にして進めてください



Wake up, Ghidra…

C:¥Ghidra¥ghidra_10.1.1_PUBLIC¥ghidraRun.bat 実行
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Create Ghidra Project

■ Ghidraは解析結果をプロジェクトという単位で管理

■ 初回起動時にはプロジェクトを新規作成する必要がある（すでに作成済みであれば不要）
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❶ File -> New Project
を選択

❷ Non-Shared Projectに
チェックボックスが入って
いることを確認してNext

❸ 遷移した先のSelect Project Location
画面で、以下設定でプロジェクトの作成
（講義ではこのディレクトリをプロジェクト
のディレクトリとして扱う）



import file

■ Ghidraでは、解析対象となるファイルをProjectに「import」して作業する

○ 「C:¥yara_pretty_darby¥ファイル名.gzf」を使用
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❶ 作成したプロジェクト
画面にファイルをD&D

❷ ポップアップが表示
されたら「OK」

❸ プロジェクト画面にファイルが
表示されていればインポート完了



Code Browser
25

Listing View

ディスアセンブル結果・データを表示

Decompile View

Listing Viewのデコンパイル結果を表示

Console

スクリプトの標準
出力結果を表示

Data Type Manager

独自構造体などのデータ型
を管理

Symbol Tree

インポート/エクスポート
関数、関数名、クラス名な
どなどを列挙

Program Tree

セクション名などを表示

開く



Other Window
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特定のアドレスに対し、名前を
つけてブックマークとして保存

HEXエディタ

プログラムに含まれる可読文字列

ディスアセンブル結果を
グラフ形式で表示

Pythonインタプリタの起動

Ghidra Scriptを管理するマ
ネージャの起動



Load gdt

■ 解析に必要なAPIの情報を追加する

27

❶ ▼からOpen File Achiveを選択

❷ winapi_32.gdtを選択

❸ winapi_32を右クリックして、
Apply Function Data Typesを選択



Code Browser: Listing View

ディスアセンブル結果や、データ領域の
データを表示・操作する画面

■ Decompile Viewでざっと流れを確認し、細
かい処理をListing View で眺める

■ あらゆる処理をデコンパイルできるわけで
はなく、常に正しくデコンパイルできるわ
けでもないので、Listing Viewに頼るほか
ない場面も多い
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関数のディスアセンブル結果を表示

データを表示

ローカル変数

API呼び出し

関数呼び出し

ラベル名

データ領域の
参照

ラベル名

データ（文字列）



Go to ...

■ Gキーを押すとGo to ... ポップアップが表示される

○ 任意のアドレス、ラベルを入力してジャンプできる
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Code Browser: Decompile View

デコンパイル結果を表示する画面

■ Ghidraは、機械語をP-CODEという中間表
現に変換後、擬似C言語にデコンパイルし
ている

■ 常にデコンパイルできるわけではないし、
常にデコンパイル結果が正しいわけではな
いことに注意

■ データは表示できない
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ローカル変数の定義（ハンガリアン記法）

関数のプロトタイプ定義

データ領域の参照



Defined Strings

バイナリ内の可読文字列を表示

■ 「Window > Defined Strings」から開く

■ クリックすると、文字列が定義されてい
るアドレスが Listing Viewに表示される

■ コンパイラによって自動で埋め込ま
れた本来のコードと無関係な文字列
も多いので注意

■ Ghidraが文字列として認識できてい
ない場合は現れないので注意
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Symbol Tree

シンボル情報をカテゴライズして表示

■ Imports

○ ImportしているAPI一覧

○ APIベースで解析を進める際に参照

■ Exports

○ Exportされている関数一覧

○ entryはプログラムのエントリーポイント

○ DLLの場合は、Export関数がみえる
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Make YARA rule 



meta Section

■ metaセクションを記述

○ author: 作成者の情報を記述

○ created_date: 作成日

○ modified_date: 編集日

○ hashn: ルールの作成に使ったファイルのハッシュ

○ description: 検出ルールの説明
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Step1: strings rule

■ Defined Stringsウィンドウから特徴的な文字列を選択してルールを作成
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Step2: behavior rule

■ Symbol TreeウィンドウのImportsから特徴的な挙動を実現するAPIを選択してル
ールを作成

■ 明示的な解決の場合は文字列やバイト列を利用してルールを作成する
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How Windows APIs are resolved

■ 暗黙的な解決

○ コンパイル時に、必要なAPIがインポートテーブルに定義され、実行時にOS
が暗黙的にDLLをロードし、APIを解決する

○ 普通にコンパイルするとこの方法で解決される

■ 明示的な解決（動的API解決）

○ LoadLibrary / GetProcAddress を用いて実行時に動的にAPIを呼び出す

■ 実行時にAPI名を復元してGetProcAddressの引数に渡すことで難読化

○ APIハッシュを使ったAPIのアドレス取得手法

■ JSAC2021の資料で解説

37



API List

■ https://malapi.io/ を参考にマルウェアが利用するAPIを調査する

38

https://malapi.io/


Step3: effective rule

39

変更しづらいコードをみつける

• 文字列は変更しやすい

• マルウェア固有のアルゴリズムやコード
は変更しづらい

可変なコードは可変なままで

• アドレスなどコンパイラによって可変な
ものはワイルドカードにする

• 定数など攻撃者が変更する可能性がある
値もワイルドカードにする



Effective rule Sample

■ 一部の定数のみが異なる、2種類の文字列の復号ルーチン

40

定数やレジスタなどが
変わっても検出可能な

パターン



Tool: YaraGhidraGUIScript
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❷ Filterで絞り込み

❶ Ghidra Scriptを
管理・実行するためのScript Managerを開く

❸ スクリプトを
選択した状態で ▶︎



Tool: YaraGhidraGUIScript Usage 1
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❶ パターンを作成したい箇所
を選択

❷ コードを選択した
状態で更新

❸ YaraルールをGUIで
ぽちぽち編集可能



Tool: YaraGhidraGUIScript Usage 2

■ 命令列、データをYARAルール用のHEX文字列に自動変換

■ 手動でマスク（=ワイルドカードに置き換え）、もしくはバイト列の属性に応じ
て自動マスク
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元に戻す（アンマスク）

データ（命令以外）をマスク

オペランド（引数）をマスク

スカラー（実数）をマスク

アドレスをマスク



Anatomy of SpiderPig Family
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Overview of SpiderPig Family

■ BlackTechが利用するPEローダとカスタムバックドア

45

SpiderPig Loader 
(Local)

SpiderPig Loader 
(Remote)

SpiderPig RATEncrypted data

外部サーバから、特定のフォーマット
を持つ暗号化されたペイロードを
ダウンロードし復号

特定のフォーマットを持つ暗号化
されたペイロードをローカルフォルダ
内から検索し復号

メモリ上で実行



SpiderPig Loader (a.k.a. selfmake Loader)

■ オンメモリPEローダ、OSSのソースコードをカスタムして悪用している

○ https://github.com/abhisek/Pe-Loader-Sample/blob/master/src/PeLdr.cpp
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SpiderPig Loaderのデバッグメッセージ PeLdr.cppのデバッグメッセージ



SpiderPig Loader: Local

■ ローカルから暗号化されたペイロード
を検索するタイプ

○ gzf: SpiderPig_Loader_local.gzf

○ SHA256: 
8bdfc1ed5bfec964050a42a0f1ddd
8709fcf14fab1ede151c5a7161be90
4cd96

■ 大まかな実行フロー→
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FUN_003029f0

FUN_00302460

FUN_00301ee0

FUN_00301cf0

FUN_00301a10

FUN_00301c90

FUN_00301bd0



SpiderPig Loader: Local
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FUN_003029f0

FUN_00302460

FUN_00301ee0

FUN_00301cf0

FUN_00301a10

FUN_00301c90

FUN_00301bd0

実行ファイル名から拡張子を削除
FUN_00302410に渡す

先頭4バイトを読み込ん
で0xe0ffd8eeと比較



SpiderPig Loader: Local
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FUN_003029f0

FUN_00302460

FUN_00301ee0

FUN_00301cf0

FUN_00301a10

FUN_00301c90

FUN_00301bd0

先頭4バイトのシグネチャをチェック

XOR鍵取得

ペイロードのサイズ取得

暗号化されたペイロー
ド部分を読み込み

XORで復号



SpiderPig Loader: Remote

■ 外部サーバから暗号化されたペイロード
をダウンロードするタイプ

○ gzf: SpiderPig_Loader_remote.gzf

○ SHA256: 
7da969010a55919aa66ed97a2d2d6
d6a0be3d8dc6151eeb6cebc15e4f06
d4553

■ 大まかな実行フロー→

50FUN_00102ab0

FUN_00101aa0

FUN_001025f0

FUN_001027d0

FUN_001023c0

FUN_00102080

FUN_00102360

FUN_00102250



SpiderPig Loader: Remote

51FUN_00102ab0

FUN_00101aa0

FUN_001025f0

FUN_001027d0

FUN_001023c0

FUN_00102080

FUN_00102360

FUN_00102250

通信先情報を含むコンフィグのデコード



SpiderPig Loader: Remote

52FUN_00102ab0

FUN_00101aa0

FUN_001025f0

FUN_001027d0

FUN_001023c0

FUN_00102080

FUN_00102360

FUN_00102250

FUN_00101aa0に通信先と保存先を渡してダウンロード

一時ファイルに保存



SpiderPig Loader: Remote

53FUN_00102ab0

FUN_00101aa0

FUN_001025f0

FUN_001027d0

FUN_001023c0

FUN_00102080

FUN_00102360

FUN_00102250

シグネチャのチェック後、ヘッダからXOR鍵やサイズを
取得しペイロードを復号

先頭4バイトのシグネチャをチェック XOR鍵取得

ペイロードのサイズ取得

暗号化されたペイロード部分を読み込み

XORで復号

復号後のデータがvalidな
PEファイルかチェック



SpiderPig Loader: Remote

54FUN_00102ab0

FUN_00101aa0

FUN_001025f0

FUN_001027d0

FUN_001023c0

FUN_00102080

FUN_00102360

FUN_00102250

”fixmeconfig”を検索

暗号化されたコンフィグをコピー

復号したペイロードに埋め込まれた“fixmeconfig”という
シグネチャを検索し、そこに暗号化コンフィグをコピー



Tips for Detection

■ まずは検知ロジックに組み込みやすい文字列からYARAを作成してみる

■ 次に、SpiderPig Loaderには存在していてOSSのPeLdrには存在しないコードや
文字列部分を特定して、ロジックに組み込む

■ 変更されにくそうな部分をロジックに組み込む
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YARA Pretty Darby

4
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我々が用意した約1万
ファイルの中から13の

SpiderPigファミリを見つけ
出す「いい」YARAルールを
書いてもらう、全員参加型

ダービー戦！



Darby
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Flow

1. Ghidraを使ってYARAルールを作成

2. ローカルテスト

○ 正しくルールが動作するか検証する

3. Webサーバのデータセットでテスト

○ 指定されたハッシュがすべて含まれるか (False Negative)

○ 指定されたハッシュ以外が含まれないか (False Positive)
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Test YARA rule
(Local Testing)



What is ghidra_yara.py ?

■ Ghidra にインポート済みのファイルに対してスキャン可能なYARA 
(yara_scanner.exe)を利用するGhidraScript
○ 通常のYARA ではGhidra Project 内に含まれている解析対象の

ファイル本体をスキャンできない

○ 解析対象のファイル (マルウェア) を直接取り扱うのは危険が伴う

61

YARA Rule

yara_scanner.exe
ghidra_yara.py Ghidra Project

Scan

Execute

+Imported
File

Result



Step1 : How to use ghidra_yara.py

■ Script Managerからghidra_yara.pyを選択して実行
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❶ Ghidra Scriptを
管理・実行するためのScript Managerを開く

❸ スクリプトを
選択した状態で ▶︎

❷ Filterで絞り込み



Step2 : How to use ghidra_yara.py

■ YARAルールのファイル選択ダイアログが表示されたら、
スキャンしたいYARAルールのファイルパスを選択

○ C:¥ghidra_scripts¥rule.yaraを設置すると省略可能
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Step3 : How to use ghidra_yara.py

■ Consoleウィンドウにスキャン結果が表示される

○ マッチした場合は、そのルール名が表示される
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Step4 : How to use ghidra_yara.py

■ Bookmarksウィンドウで検知結果の詳細を確認

○ [Window] -> [Bookmarks]から起動

○ "ghidra_yara"でフィルタして確認

○ Locationをダブルクリックすることで、マッチしたアドレスに移動可能
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Evaluation YARA rule
(Test Dataset)



mquery

■ CERT PLが開発したOSSのYARA検索用のWebサービス

○ https://github.com/CERT-Polska/mquery

○ 大量のデータを高速に検索することができる

■ 演習ではAllsafeが用意した環境を利用する

○ アクセス方法はslackで共有
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https://github.com/CERT-Polska/mquery


mquery Usage

68

YARAルールを入力

検索を実行

構文の検証

メタセクションのauthorの情報が
投稿者を識別するのに利用される



Parse

■ 構文エラーをチェック

○ 基本的にはローカルでチェックするため利用しない
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Query

■ 検索結果を表示

■ 正解のハッシュしか含まれないか
を確認する

■ ルールをトライアンドエラーで
修正する

70



Query (Show query)

■ 左上のShow queryから実行したクエリを確認できる
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Recent jobs

■ 過去のqueryを確認できる

○ ユーザ毎に分離はされていないのでAuthorを目印に自分の投稿を探す
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Cancel

■ 想定以上に検知されてしまうルールは右上の停止ボタンからキャンセルする

○ サーバの負荷軽減にご協力お願いします
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YARA Pretty Darby Play Book

DO

✓ フォーマットに従って書く

• Meta情報を埋める

• ルール名を統一する

• 公式の構文に従う

✓ なぜ・なにを検知しようとしたのかわか
るコメントを書く

✓ 検出の目的を加味し、誤検知の許容範囲
を意識してルールをつくる

✓ 可能であればバイト列を含めたルールを
作成する
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DO NOT

✓ 4文字未満の短すぎる文字列を避ける

✓ 特徴的でない文字列を避ける

• PEに必ず含まれる文字列

• 正規プログラムでも利用されるユーザエー
ジェントなどの文字列

✓ 正規表現を利用する場合はパフォーマンスに気を
つける

• 文字数を制限しない正規表現を使わない

✓ 同一ファイル内でマッチしすぎるルールを避ける



Good Rule vs Bad Rule
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Good Bad



Dataset

■ ターゲット

○ SpiderPig Loader: 9

○ SpiderPig Rat: 4 (+ 1)

■ PEマルウェア

○ 9772
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Sample

■ SpiderPig Loader Remote

○ 7da969010a55919aa66ed97a2d2d6d6a0be3d8dc6151eeb6cebc15e4f06d4553

■ SpiderPig Loader Local

○ 8bdfc1ed5bfec964050a42a0f1ddd8709fcf14fab1ede151c5a7161be904cd96

■ SpiderPig RAT

○ d196969b35966462fa03ef857e375e9d6172b34053b115df04cefa3d673b9d85
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Ground Truth

■ SpiderPig Loader Remote

○ 7da969010a55919aa66ed97a2d2d6d6a0be3d8dc6151eeb6cebc15e4f06d4553

○ 1e25116f33f7248e4549cb15fb20bd5d9f87cc7424e6592e565d66095ec2b647

○ 2321690bb6cab49c9eb828c4b65182ceb05653479fe900b9e6dbd93a0b9a672f

○ 90406d0fc975f342f0e20b49e7946e891392eb06bfc8cc5f3b9b8c86b7c1b17a

○ 3891fb7b3d1e5fc2d028ed3d0debe868189971b20eb8edb295e2b8d2d0c1a02a

○ 5a57c9d19c7fb42832085f88d92f9f57d64b1bca8f2a19b0533a4caee1a792cc

○ 2657ca121a3df198635fcc53efb573eb069ff2535dcf3ba899f68430caa2ffce

■ SpiderPig Loader Local

○ 8bdfc1ed5bfec964050a42a0f1ddd8709fcf14fab1ede151c5a7161be904cd96

○ 92c75df382218e7743359aa83b403e443550e766c8474a59c9dcbd4903a4bf02

■ SpiderPig RAT

○ 8c3df0e4d7ff0578d143785342a8033fb6e76ce9f61c2ea14c402f45a76ab118

○ c2b23689ca1c57f7b7b0c2fd95bfef326d6a22c15089d35d31119b104978038b

○ d196969b35966462fa03ef857e375e9d6172b34053b115df04cefa3d673b9d85

○ 733b4d5174669caab2bbcc9bfe51606a13346b70af59fccea4f479d1fde7b5d7

○ Dced553a6f835162f0515a41a330404466f3ca44bc43a2f8b5675ca28609c905 (x86) //実装が異なるため検知できなくてもよい
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出走！



Solutions

■ 別途配布するPDFを参照
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Summary

■ 単に検出できるかどうかだけではなく、検出の目的や効率を考慮した「いい」
YARAルールを書くように心がけましょう

■ 「いい」YARAルールは、反復検証の結果として出来上がるので、仮説→検証を
繰り返しましょう

■ 書いたYARAルールをコミュニティに共有してみましょう
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